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A) Introduction 
 
Writing a paper in mathematics is probably a new experience for you. 
It has much in common with writing papers in your other subjects. For 
example, all your papers should avoid mistakes in spelling and 
grammar and your conclusions should be well supported by you 
arguments. However, each subject area has its own special needs 
and requirements. This manual should be of help to you in meeting 
these needs and requirements in the field of mathematics. It is not 
meant to replace the writing handbook you use in your writing 
courses but to supplement it.  
 
Throughout this manual many of the suggestions given will be 
illustrated with the paper, Playing Games with Mathematica, by Cowen 
and Dickau, which appeared in the journal Mathematica in Education 
and Research in 1998 [Volume 7, Number 3, pp.5-10]. A complete 
copy of the paper can be found in the appendix. We shall refer to this 
paper as the "Games paper."  Also the text for the course, 
"Discovering Mathematics with Mathematica," (Cowen,R. and 
Kennedy, J., Erudition Press, 2001) also provides a model of 
mathematics writing based on Mathematica investigations. 
 
In order to introduce you to scholarly writing in the field of 
mathematics, we will assume that the paper you produce is to be 
submitted to a math journal and advise you accordingly. Then, if your 
results are outstanding and you write them up well, your paper will be 
ready for submission to a journal; if not, you will learn this format for 
the future. In fact if there is sufficient interest we could  produce our 
own journal from the articles produced in this class!  In any case, in 
addition to improving your mathematics writing, this should make you 
a more thoughtful reader of mathematics articles.     
 
 
 
 
B)  Finding a Problem 
 
By the time you are ready to write your paper, you will have already 
seen Mathematica investigations of many problems. Perhaps you 



have found some of these problems especially appealing and have 
questions of your own about them that have not yet been fully 
answered. Those unanswered questions can often form the basis for 
a paper, or sometimes, one of the problems from the text can serve 
as a basis for a successful research project. 
  
Also it is often possible to take a successful investigation and vary the 
conditions slightly  thereby getting a new problem to investigate.  In 
this case many of the methods used in the original problem can often 
be adapted successfully as well. In our study of games and puzzles in 
our text, even a slight variation in the rules can change the outcome 
and thus produce a new problem. For example, in Chapter 8, the 
Lights Out Puzzle is studied and, as mentioned, a solution exists for 
any size board. The rule in Lights Out is: any square that is touched 
changes the state of that square and that of its neighbors (those with 
which it shares an edge). Now suppose just the neighbors change 
their state, but not the square itself; we then have a new puzzle, 
which has been called "Orbix." It is no longer the case for the Orbix 
puzzle that any size board has a solution. The question then is: which 
ones do and which ones don't have solutions? This turns out to be a 
fruitful problem to investigate with Mathematica and, although a lot has 
been discovered so far, it is still a long way from being completely 
solved!  
  
 Another example is in the game of Cram where pieces are dominos, 
each of which cover two squares of a rectangular board. Suppose 
instead, these dominos covered three squares in a line or perhaps 
were L shaped, etc. [see the Final Remarks section of the Games 
paper for more on this]. Discovering which player will win on various 
size boards with these altered rules can also make a good research 
project. 
  
 Students have also gotten very good papers by varying the 3x+1 
problem.---say by instead using 3x+5, or 3x+7, etc. Finally, if you 
cannot find a problem that you are happy with ask your teacher for 
suggestions. 
 
Once you think you have a topic, you should write a one page 
proposal which expresses clearly what you will be investigating and 
what methods you will use. Writing proposals is a common 



experience for most researchers; often funding depends on a 
proposed course of research. So make sure your proposal is well 
written. Your teacher will return this proposal to you with comments 
on whether your project has a good chance of success, along with 
suggestions you might want to consider while conducting your 
research.  In addition your proposal will receive a grade that reflects 
the care you put into constructing the project and how well you have 
communicated your ideas for your project.  
 
 
 
C) Conducting the Research. 
 
The research for your paper can be carried out in the Lab (The hours 
that the Lab will be open during the semester will be posted.). Also 
their are other computer labs on campus which have Mathematica 
available; the City University has a site license for Mathematica and 
can put it on any computer in the University. Also you can run your 
own copy of Mathematica at home through this site license. Ask your 
instructor how to obtain your copy of the software. The advantage of 
doing your research in our Lab is that the Lab Assistant is familiar 
with Mathematica can help you if you get stuck. Also your instructor 
can help you during office hours. Some class sessions will be allotted 
to research for the purpose of providing help to you, as well. Don't 
hesitate to ask for help. It is only rarely that a student will not need 
any help at all. 
 
What might you need help for?  Here are three situations in which 
students have asked for help in the past. There are many other 
situations where help was requested as well. 
 
1.You may not be able to get anywhere with your original problem 
and could use suggestions on what to do next. 
 
2.You know what you want to have the computer investigate but you 
are unable to write correct programs that do what you want. 
 
3. You have produced very interesting data supporting your 
conjectures and you are now positive they are true, but you have no 
idea on how to prove your conjectures. 



 
 
D) Writing the Paper. 
 
A Noble prize winning physicist once joked that there are two kinds of 
math papers. "In the first kind of paper, you cannot get past the first 
page. On the other hand, in the second kind of paper, you cannot get 
past the first paragraph!"  Although this criticism is often justified (and 
applies also to physics papers}, we believe that it is possible to write 
decent, readable mathematics papers; however this takes effort. The 
purpose of this manual is to assist you in that effort. 
 
 
1. Deciding your audience. 
 
The same research can often be used in a variety of papers geared 
to different audiences. You must decide who your intended audience 
is, how much they know about the topic of your investigation, how 
familiar they are with Mathematica programming, etc. For the Games 
paper, the audience was the readers of a journal devoted to 
Mathematica, so their familiarity with this programming language could 
be assumed. (This does not mean, however, that they were all 
experts.) A good choice of audience for your paper would be your 
fellow students in this class; they are familiar with basic Mathematica 
programming, but probably not familiar with your particular topic. This 
is an especially good choice since you must also give an oral 
presentation to your classmates.  
 
2. Some general writing principles for mathematics papers. 
 
The paper should have a logical structure that seems to you to be 
natural given the research you have conducted. It is a good idea to 
write an outline to impose this structure. The structure you have 
chosen should then also feel natural to your readers. To achieve this 
you must also pay attention to transitions. The reader should feel that 
each sentence follows naturally from the one before; the same goes 
for paragraphs. This natural flow will make it easier for the reader to 
understand your work. 
 
 Try to be clear and precise in your language. Good writing takes 



work. Often it takes several revisions before the paper is ready. When 
you revise, try to find the best possible way to express each 
sentence. Many people suggest reading your work out loud to 
someone else or to yourself to catch confusing expressions. Keep 
your sentences short and to the point. Again, assume you are 
explaining to a fellow student. 
 
3. Numbering schemes. 
 
Sections should be numbered consecutively, starting with 1, for the 
Introduction (see below). Inside each section, number each result or 
comment that you may want to refer to later. For example, you can 
number theorems as Theorem 1, Theorem 2, etc., or you can use you 
your section numbers as well to number things, for example, 
Theorem 2.1 (the first numbered item in section 2), Corollary 2.2(the 
second numbered item in section 2), Definition 2.3, Remark 2.4, etc. 
This does not mean that your paper should mainly be a list of 
numbered items--quite the contrary. These items can perhaps be 
considered the bare bones of the paper; it is, however, the 
"connective tissue" which contains the "meat" of the paper and 
makes it informative to the reader. These connective parts provide 
the narration that tells how the results obtained fit together to form a 
coherent whole.  
 
4. Choice of Title 
 
A title should, generally, tell potential readers whether the paper will 
be of interest to them and it should be short. These two criteria can 
be somewhat contradictory; therefore a compromise must often be 
made. For example, "An investigation of the 3x +17 problem" is not 
very informative because no one will recognize this problem; for, 
although the 3x+1 problem is fairly well known,"3x+17" is not. On the 
other hand, "Investigating the variation of the 3x+1 problem which 
replaces 3x+1 by 3x+17," is informative but probably too long. A 
compromise might be, "3x+17, a variation of the 3x+1 problem." The 
title of the Games paper, "Playing Games with Mathematica," is 
accurate and cute and hopefully will attract readers. 
 
5. The Abstract 
 



Many journals follow the title by an abstract that makes up for the 
brevity of the title.  Its purpose is announce new results and also to 
allow the reader to make an informed decision about whether to 
spend time and effort understanding this work. This section is 
generally short and to the point.  
 
Mathematica in Education and Research did not use abstracts, probably 
in an attempt to appear less formal and more "user-friendly." 
Similarly, papers for this course do not have to have an abstract. It is 
up to you. 
 
If you want to include one, your abstract should probably consist of 
only a few sentences. An abstract is often written after the body of the 
paper is finished, so you might want to postpone writing it until then. 
 
 
6. Introducing the Problem. 
 
It is customary to have a section in which you introduce the problem 
you are investigating. You might also explain how it relates to other 
problems that have already been investigated and what results you 
have obtained. Don't worry about repeating material from the Abstract 
(assuming you have one); in fact you should make it totally 
independent of the Abstract. You can also talk about the methods you 
have used to obtain your results in a general way if you think they are 
interesting--sometimes a novel method developed to solve a problem 
is more interesting than the problem itself! 
  
You might then outline the rest of the paper telling what will be found 
where (that is, in which section). Everything here should be clearly 
laid out with as little jargon as possible. 
Keep in mind your intended audience and what they already can be 
assumed to know. For example, the readership of Mathematica in 
Education and Research can be assumed to know a lot about 
Mathematica programming, but not much about impartial games, and 
so we wrote our introductory paragraph accordingly. 
 
       Much can be learned by playing games. The beginnings of probability and 

statistics derive from questions asked by gamblers from their experiences 
at the gaming tables. Here we consider games where reasoning, not 



chance, are paramount. In particular, we consider the class of so-called 
impartial games, defined below. The basic mathematical theory of such 
games is easily explained and there is an algorithm, known as the 
Sprague-Grundy algorithm, which enables a player with sufficient 
computational resources to win, when confronted with a winnable position. 
Many interesting questions can be asked and answered by students, at all 
levels, about particular impartial games. We will show how Mathematica 
can be used to play various games and to investigate which player will win 
(assuming proper play). In this way, we can make and test conjectures, and 
can discover and prove new theorems. All this while playing games! 

 
 If the paper were intended for a journal specializing in these kinds of 
games, the Introduction, as well as the rest of the paper, would have 
to be very different! For example, if the paper were to be written for a 
journal specializing in games, we might write the Introduction 
something like this. 
      

   We investigate the impartial game, Cram. Cram is played on a 
rectangular board ruled into squares. Players take turns placing 
dominos on unoccupied squares and the last player to place a domino 
is the winner. The game has been called various names, including 
"Plugg" and "Dots and Pairs" and has been studied by various authors 
[Berlekamp, 1985]; Gardner, 1974]. We show that the second player 
wins, with proper play, on the 5 by 5 board; this solves an open 
problem in Gardner. Our proof consists of computing the Grundy 
number of the board using the Mathematica programming language; it 
is, however, necessary to break up the computation using various 
symmetry arguments. 

 
7. Division into sections 
A journal article is usually divided into sections. Give a lot of thought 
to what these sections should be; ideally, they will give your work a 
logical structure that will help you and the reader understand what 
you want to convey. It can also point out to you places in which there 
are gaps in your reasoning and hence where more work is needed. 
The Games paper, although short, is still broken up into 7 sections: 
Introduction, Impartial Games, Programming the Sprague-Grundy 
algorithm, Visualization, Large Computations, Final Remarks, and 
References. Some articles follow the Introduction with a section 
variously called "Preliminaries," or "Background,", etc., which formally 
introduces terminology that will be used throughout the paper. Others 
introduce terminology on the fly; that is, as needed.   
We have several copies of the journal, "The American Mathematical 



Monthly" around in the Lab and you are welcome to look at the 
articles in this journal to see various ways articles have been divided 
into sections, etc. 
 
8. Making Definitions 
 
In the body of the paper, you can define things properly. Avoid long 
lists of definitions and don't bother defining concepts your reader will 
already know. Deciding what to define and how general to make your 
definitions is an art that is learned by experience and reading good 
papers. It often happens that making the right definition leads to a 
breakthrough. A good definition points out a key concept that you 
think is important for your work and could be important in the future. 
For example, the definition of pi, as the ratio of the length of the 
circumference of a circle to that of its diameter, has enriched 
mathematics for thousands of years; so give some thought to your 
definitions. In the paper you will often define concepts that are 
already known in the literature but may not be known to all your 
readers; these can be defined in the body of the text, using italics for 
the defined concept.  For example: "an impartial game is a two 
person game where each player has the same set of moves." If, 
however, you are making a new definition that will play a key role in 
your paper, you may want to define it more formally, as Definition 2.4 
(4th item in section 2), say, so that you can also refer easily to this 
definition in what follows. 
  
9. Computer methods and data  
 
You should also tell what methods you are using to obtain your 
results, what computer programs you are using, and if they are short, 
include them in the section; otherwise put them in an appendix. Also 
tell how your programs were obtained--that is, are they simple 
modifications of programs used in the course or are they original 
programs you created from scratch to meet a special need. Explain 
what data you have obtained with the programs, how you are running 
the programs, and also any tests you have run to ensure that the 
programs are correct--if this is an issue. 
  
 Be sure to present your data as clearly as possible, whether in 
tabular form or as a graph, making sure to label axes or table entries, 



and then carefully explain how your data supports your conclusions. 
Examples of good diagrams and tables can be found in your textbook 
, in the Mathematica manual (included with the software) and in 
journals available in the Lab  
 
 
10.  Conjectures and Proofs 
 
It is often possible to make conjectures based on evidence obtained 
from computer data. For example, for the Orbix puzzle, two students, 
in two different classes came up with the same conjecture, that the n 
by n square grids with n even, always have a solution, while if n is 
odd, there is never a solution. They based this on their computer 
solutions for even boards up to 100 by 100, along with the computer 
indication of the lack of a solution when n is odd.  This is a bold 
conjecture, but seemed warranted from the evidence obtained.  In 
fact, I, together with some colleagues at Queens, have been able to 
prove this conjecture, so that now it is a Theorem.  
 Even if you cannot prove your entire conjecture it may be possible to 
prove parts of it.  For example, if you have a conjecture about all 
rectangular grids that you are unable to prove, perhaps you can 
prove it for all grids of width 2 or 3, etc. It often helps to try these 
small cases by hand rather than with the computer.  
 
If you verify with the computer a large number of special cases of a 
general conjecture, this should be reported, together with how long it 
took your programs to run on the computer you used.  
Try to find ways to run more or bigger cases by improving your 
algorithm or programming, using symmetry arguments (see the 
Games paper for an example of this) etc. It is interesting that the 
3x+1 conjecture has now been verified for extremely large numbers. 
 
 
11. The Conclusion 
 
It is desirable to have a final section that can be called "Conclusion" 
or "Final Remarks." Here is where you sum up your major 
accomplishments in the paper and suggest areas that might be 
fruitfully investigated, by you or others, in the future. You can also 
thank anyone who has provided significant help to you in the 



preparation of your paper. 
 
Things that do not belong in the Conclusion include your enjoyment 
or lack of enjoyment in producing this work, your personal feelings 
about the material, etc. This is a scientific work and you are not the 
subject of this inquiry.  
 
12. References  
 
Any time you use material from another source in your paper, you 
must give a reference to that source. This is done by explicitly stating 
the nature of your indebtedness in the text followed by a number in 
brackets that is the number of the source in the list of references 
provided by you at the end of your paper. In addition, references are 
often used to inform the reader where more material on a certain 
topic can be found. 
 
References should be listed in alphabetical order using the last 
names of the first listed author to determine order. For example, a 
journal article might be listed as:  
 
[1] Bartels, J., Smyth, P., A decision procedure for qualification 
theory, J. Local and Global Analysis, 12(1999), 14 - 23. 
 
Here 12 is the volume number, 1999 is the year of publication, and 14 
- 23 are the pages in which the article appears. 
 
A book might be referenced as:  
 
[2] Davidson, M., Recursive Algorithms, Cambridge University Press, 
Cambridge, England, 2002. 
 
A source you found on the Internet is cited similarly with the addition 
of the words, "online," and date of your visit to the site, as well as the 
URL. 
 
Different math publications can have slightly different ways of listing 
references. Choose one format and follow it. For examples, look at 
the American Mathematical Monthly or any math journal in the QC 
Library.  



 
 
13. Typing the paper 
 
There are many choices for typing your paper. Assuming you are 
going to use a computer to word process, Mathematica itself is quite 
capable as a word processing program. The Games paper was 
produced with Mathematica. In Mathematica each cell can be 
designated as an input or text cell. The default is input. To change to 
text, use the pull-down Format menu; select "style" and then "text." 
The Format menu can also be used to change the font, face (bold, 
underline), size of font, justification, etc. Math symbols are available 
using the Palettes (on the File menu). 
 
Microsoft Word can also be used to produce the paper.  Many math 
symbols are available(pull down the Insert menu and select "symbol") 
and programs and diagrams can be exported from Mathematica.  
Diagrams and programs from Mathematica can be copied and pasted 
into your Word document; use "Copy As" and select "PICT" in  
Mathematica and then use "Paste" from the Edit menu in Word. 
 
Many mathematicians use Tex to produce professional quality 
documents; however,  unless you are very familiar with this method of 
document preparation it is best to use Mathematica or a standard word 
processing program, such as Word. 
 
14. Submitting your paper.  Your paper is due on the day the final 
examination for the course is scheduled. If you want it returned with 
comments from your instructor, enclose a stamped self-addressed 
envelope with sufficient postage as well as a second copy of your 
paper. Your instructor will retain one copy. 
 
 
 
E) The Oral Presentation. 
 
In addition to submitting the written paper you will have to make an 
oral presentation of your results to the class. Your presentation will 
receive a grade and will be counted toward your final grade.  
 



Mathematicians often attend conferences where they give oral 
presentations of results they have obtained  to other interested 
mathematicians. These presentations can range in duration from 10 
minutes to an hour. You will have 15 minutes for your presentation. 
Of course one usually cannot present a full paper in such a short 
time, so the problem is what to present and how to present it. In 
general it is a bad idea to simply project to the audience pages of 
your written paper. Instead you should try to convey your most 
important findings. These should be motivated and explained.  
 
Don't put too much on any one slide (projected page of your 
presentation). Use type big enough to be seen at the rear of the 
room. It is best to just outline your remarks on each slide, and not to 
read verbatim from the slide. Any visual material you can include is 
welcome!   
 
You should practice giving your talk several times before you give it 
to the class. See that it doesn't need more time than allotted. We will 
set aside one class for practicing your talk. Students will break up into 
groups of about three and give their talks to each other. This can be 
done in clusters using the computers around the room and also it will 
be possible to project a few slides from the front of the room to see 
how they will appear to your audience. You will give and receive 
advice that, should result in a better presentation. Sheets will be 
provided to guide you in giving advice. These will consist of a list of 
criteria on which a talk can be evaluated.   
 
Slides can be prepared using Mathematica. In fact Mathematica 5 
makes special provisions for creating slide shows. See that help 
browser for more on this. It is even possible to give a dynamic 
presentation using Mathematica in that you could run programs 
during your talk to show results obtained. However it is often better to 
just show the output previously obtained because sometimes things 
don't run as you intended on a different computer and this can be 
embarrassing. Alternatively a presentation can be assembled using 
software such as PowerPoint if you are familiar with it. 
 
 
 
 




